
How You Use the Timeline
The Timeline and the Canvas display two different views of the same sequence. The Timeline shows the
chronological arrangement of clips and layered video and audio clip items, while the Canvas provides a single
view that allows you to watch your sequence just as it will appear on a movie or television screen.

The Timeline, like the Canvas, contains tabs for all open sequences. Each sequence in the Timeline is organized
into separate video and audio tracks, which contain clip items you’ve edited into the sequence from the Browser.
Using the Timeline, you can quickly navigate through an entire edited sequence, adding, overwriting,
rearranging, and removing clip items.

The Timeline window below shows several items in the Timeline.

This image shows the same items as they appear in the Canvas.

Since the playhead in the Timeline mirrors the playhead in the Canvas, you can use the navigation, marking, and
editing controls in the Canvas to navigate in the Timeline, and vice versa.

To make the Timeline window active
Do one of the following:

Click in the Timeline window.

Press Command-3.

Note: To work in the Timeline, the first thing you have to do is open a sequence. If you don’t have any
sequences in your project, you need to create one. For more information, see Working with Projects, Clips, and
Sequences.
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Learning About the Timeline
You can view the content of your sequences in many different ways in the Timeline. Track height, clip opacity
and audio level overlays, keyframes, and many other sequence properties can be displayed and edited in the
Timeline. Each sequence has its own unique display settings; changing the zoom setting or audio controls in one
sequence doesn’t affect another.
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Vertical Multitrack Controls
The following controls and areas affect vertically working with the tracks.

Tracks: The main portion of the Timeline is divided into audio and video tracks, with a divider between the
two regions. You can drag the divider up or down to allocate more room to either the video or audio half of
the Timeline. Audio tracks 1 and 2 are just underneath the divider, and all additional audio tracks continue
downward. Video track 1 is just above the divider, and all additional video tracks continue upward. For more
information, see Working with Tracks in the Timeline.

You can change the default number of video and audio tracks in the Timeline Options tab of the User
Preferences window. For more information, see Choosing Settings and Preferences.

More tracks can be added at any time. Additional audio tracks can be used for adding music or sound effects,
or for organizational purposes. Additional video tracks can be used for superimposing clips and compositing
layers of video clips together.
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Unused area: This is the area either above or below the outermost video and audio tracks in your sequence.
Ordinarily, this area is blank, but if you drag clips directly into this gray area, new tracks are created to
accommodate them.

Vertical scroll bars and thumb tabs: If you have more tracks than can be displayed in the Timeline window at
one time, the scroll bars let you scroll through your video and audio tracks separately. The thumb tabs
between the audio and video track regions can be used to define a static area that contains separate groups
of audio or video tracks with their own scroll bars.

This can come in handy when you have considerably more audio tracks than video. You can use the thumb
tabs between your audio and video scroll bars to allocate more space to your audio tracks and less for video.
For more information about creating a static area, see Working with Tracks in the Timeline.
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Horizontal Time Controls
The following controls and areas affect horizontally working with the tracks.

Ruler: The ruler along the top of the Timeline represents the total duration of your edited sequence, from the
first frame to the last. The ruler can be used for reference, to see the timecode corresponding to the location
of clips in the Timeline. You can choose to view the ruler with several different units: timecode, frames, or
feet and frames (for editing footage that originated on film).

You can also click or drag the playhead in the ruler, which works exactly like the scrubber bar in the Canvas.

Sequences can be a maximum of twelve hours (with a sample rate of 48 kHz or lower), or six hours (with a
sample rate of 96 kHz).

Playhead: The playhead displays the current frame location in a sequence. You can also use the playhead to
navigate through your sequence in the Timeline. For more information, see Navigating in the Timeline.

Current Timecode field: Indicates the timecode position of the playhead. Typing a new timecode number
moves the playhead (as in the Viewer and Canvas).

Zoom control: Lets you zoom in and out of the contents of your sequence in the Timeline. Zooming in shows
more detail in the ruler, and the duration between the numbers in the ruler shrinks. Zooming out shows less
detail in the ruler, but allows you to see more of the total duration of your sequence in the Timeline. If the
playhead is visible, it stays centered when you use the Zoom control to zoom in on the Timeline. If the
playhead is not visible, the Zoom control centers the current contents of the Timeline window instead.

Using the zoom keyboard shortcuts produces slightly different results. Pressing Option-Equal Sign (=) or
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Option-Hyphen (-) zooms in or out of the contents of the Timeline no matter which window in Final Cut Pro
is currently active. If one or more clips are selected, they will be the center of the zoom. Otherwise, zooming
centers on the current position of the playhead.

Note: If you want to zoom in and out around the current playhead, make sure no clips are selected in the
Timeline.

Zoom slider: Like the Zoom control, the Zoom slider allows you to zoom in and out of a sequence in the
Timeline. Dragging the thumb tabs on either side of the slider adjusts both thumb tabs and leaves the visible
area of the Timeline centered.

Pressing the Shift key and dragging one of the thumb tabs locks the opposite thumb tab and moves the
visible area of the Timeline in the direction you’re dragging. The light gray indicators inside the scroll bar
indicate one-minute increments in your sequence, and widen or narrow depending on how far into your
sequence you’ve zoomed.

Once you’ve zoomed in to your sequence, you can scroll along the entire duration of the sequence by
dragging the center of the zoom slider.
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Editing Controls
The Timeline editing controls determine which tracks are selected and turned on for editing and playback.

Source and Destination controls: These allow you to connect (or patch) clip items of the source clip in the
Viewer to tracks in the Timeline. These controls are primarily used in three-point editing to determine which
source clip items’ tracks are edited into your sequence, and where they are placed.

The number of available Source controls corresponds to the number of clip items of the source clip currently
open in the Viewer. For example, a typical DV clip has one video track and two audio tracks. In this case, one
video and two audio Source controls appear in the Timeline. If, instead, you open a clip in the Viewer that has
one video item and four audio items, then one video and four audio Source controls appear in the Timeline.
For more information, see Three-Point Editing.

Track Visibility control: Determines whether the contents of a track are displayed and rendered in your
sequence. When a track is disabled, it appears darkened in the Timeline, but its contents remain in your
sequence and can still be edited. When you play back your sequence, disabled tracks don’t appear in the
Canvas or on an external monitor, nor will they be rendered or output to tape with that sequence.

Note: Render files for a track are deleted if the track is disabled. You can have Final Cut Pro display a warning
before this occurs by selecting the “Warn if visibility change deletes render file” option in the Editing tab of
the User Preferences window. For more information, see Choosing Settings and Preferences.

Lock Track control: Prevents a track’s contents from being moved or changed in any way. Overlays in locked
tracks can also be protected by deselecting the “Pen tools can edit locked item overlays” option in the Editing
tab of the User Preferences window. Locked tracks are cross-hatched all the way across the Timeline. Tracks
can be locked and unlocked at any time. For more information, see Choosing Settings and Preferences.

Auto Select control: Enabling the Auto Select controls of specific tracks in the Timeline limits which tracks are
affected by various functions such as copying, pasting, deleting, the Match Frame command, and so on.

Note: You can think of In and Out points as limiting your edits in the horizontal (time) dimension and Auto
Select as limiting your edits in the vertical dimension.
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Audio Controls
The following controls affect vertically working with audio in the tracks.

Audio Controls button: Click to display the mute and solo buttons to the left of each audio track in the
Timeline. By default, these controls are hidden.

Mute and solo controls: Use to turn on or turn off audio playback on individual tracks for monitoring
purposes. The track strips in the Audio Mixer have corresponding mute and solo buttons that work the same
way. For more information, see Overview of the Audio Mixer.

Mute: Click to turn off audio playback for that track. The mute button affects monitoring during playback
only. Muting a track does not delete panning or audio level keyframes for the clip items in that track, nor
does it prevent fader automation.

Solo: Click to listen only to an individual track. When you solo a track, all others are muted except other
tracks already soloed. For example, if you click the solo button on track A1, and it’s the only track with
solo selected, all other audio tracks are muted. If you turn on the solo button on multiple tracks, all tracks
with solo turned on play back, while all other tracks are muted.

Note: Mute and solo controls affect only playback in the Timeline. They do not suspend audio output during
Print to Tape or Edit to Tape operations, or when exporting to a movie or audio file.
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Positioning the Playhead Using the Ruler
Moving the playhead in the Timeline ruler works in the same way as moving the playhead in the scrubber bar in
the Canvas or Viewer.

To scrub through a sequence in the Timeline

Drag the playhead in the Timeline ruler.

To jump to a specific location in the Timeline

Click the desired location in the Timeline ruler. (You can do this while your sequence is stopped or playing.)
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About Timeline Display Controls in the Timeline
Several controls in the Timeline allow you to change the display of certain items in the Timeline.

Clip Keyframes control: Click this button to display the keyframe graph area—additional space below each
video and audio track in which to view and edit keyframes for effects that are applied to your clips.

Clip Overlays control: Click this control to display opacity overlays (thin black lines) over your video tracks,
and audio level overlays (thin red lines) over any clips in the audio tracks of the Timeline. These lines indicate
video transparency or audio levels.

Track Height control: Use this control to switch between four track display sizes—Reduced, Small, Medium,
and Large. The current setting is highlighted in blue and has a small dot in the center. Choosing a track
height with this control resets all tracks to the new size, overriding any custom track heights previously
selected. To preserve the relative heights of individually sized tracks while resizing all tracks, hold down the
Option key while choosing a new height with this control.

Note: When the track size is set to Reduced, neither audio waveforms nor thumbnails are displayed.
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Real-Time Effects and the Render Status Bar
Following are the Timeline’s real-time and render items.

RT pop-up menu: Allows you to adjust the playback quality of real-time effects in Final Cut Pro. Using the
options in this menu, you can decide which is more important to you—visual playback quality, or maximizing
the available effects that can be played back in real time. For more information on the options in the Real
Time Effects pop-up menu, see Using RT Extreme.

Render status bar: This bar at the top of the Timeline indicates which parts of the sequence have been
rendered at the current render quality. The top line is for video, the bottom for audio.

Video render bar (upper region): Indicates the presence and render status of video effects items.

Audio render bar (lower region): Indicates the presence and render status of audio effects items. Colors in
the render bar above items indicate whether the items need to be rendered. Items that don’t need to be
rendered have dark gray bars above them. For more information, see Using RT Extreme. You can also refer
to Rendering and Video Processing Settings.

Clip item render bars: Audio clip items can be rendered individually. Clip items in the Timeline display
individual render bars in the following cases:

Audio clip items that require sample rate conversion: For example, audio clips that were captured at
44.1 kHz but have been edited into a sequence set to 48 kHz.

Audio clip items with filters applied: Applying one or more filters causes an audio clip to display a render
bar within the clip item itself.

For more information about clip item render bars, see Rendering and Video Processing Settings.
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Other Miscellaneous Controls
Following are other controls within the Timeline.

Snapping button: Click to turn snapping on and off. This button appears in the Timeline button bar by
default. When snapping is on, the playhead “snaps to” key areas in the Timeline, such as the boundaries of
other clip items, sequence markers, and sequence In and Out points. This can be extremely useful when you
need to quickly line up two clips without gaps in between, or to quickly move the playhead to a marker in
preparation for an edit. You can also turn snapping on and off by choosing View > Snapping (or by pressing
N).

Linked Selection button: Click this to turn linked selection on and off. With linked selection on, clicking a
video or audio clip item selects all other items linked to that item. If linked selection is off, only the clip item
you click is selected, even if it is linked to other items. This is useful for editing the audio In or Out point of a
clip separately from the video, such as when doing a split edit. You can also turn linked selection on and off
by choosing Edit > Linked Selection (or by pressing Shift-L). For more information, see Linking and Editing
Video and Audio in Sync.

Link indicators (within clip items): The names of linked video and audio clip items are underlined. As long as
linked selection is on, when one linked item is selected, moved, or trimmed, all other items linked to it are
affected identically.

Labels (within clip items): If any clip items in your edited sequence in the Timeline have been labeled, their
names are highlighted in the color that matches that label. You can choose whether clip labels are displayed
in the Timeline by selecting the Show Clip Labels option in the Track Layout pop-up menu.

Speed indicator (within clip items): If the speed of a clip has been changed, either by using a fit to fill edit or
using the Speed item in the Modify menu, its change of speed will be shown in parentheses after the name of
the clip in the Timeline. If variable speed has been applied, the word “Variable” appears instead.

Tip: Optional speed indicators can be displayed in the keyframe graph area to show you the speed of clips in
your sequence using tick marks. For more information on clip keyframes, see Changing Motion Parameters.
You can also refer to Adjusting Parameters for Keyframed Effects. The spacing and color of these tick marks
indicate the speed and playback direction of your clips. For more information, see Changing Clip Speed.

Stereo pair indicators (within clip items): Two pairs of triangles indicate that two audio clip items are linked as
a stereo pair. If you select an audio clip item that is part of a stereo pair, the other clip item in the pair is also
selected. This is useful when you are working with stereo audio clips such as music or sound effects. For
more information, see Audio Editing Basics.
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